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(MS WINDOWS 7-WINDOWS 10, MS OFFICE 2013 TRỞ LÊN) 

 

CÂU HỎI LÝ THUYẾT PHẦN KIẾN THỨC CƠ BẢN MÁY TÍNH 

 

1. Các hệ điều hành máy tính thông dụng hiện nay thường được lưu trữ : 

A. Trong CPU       B. Trong RAM 

C. Trên bộ nhớ ngoài       D. Trong ROM 

2. Phát biểu nào sau đây về RAM là đúng 

A. RAM có thể đọc và ghi dữ liệu   

B. RAM có dung lượng lớn hơn đĩa cứng 

C. RAM có chức năng giống như ROM   

D. RAM chỉ cho phép đọc dữ liệu 

3. Nhóm thiết bị nhập thông tin vào: 

A. Bàn phím, máy quét, máy chiếu,Webcam   

B. Chuột, bàn phím, Webcam, máy quét 

C. Máy quét, tai nghe, bàn phím, micro   

D. Webcam, micro, loa, bàn phím. 

4. Chọn thứ tự tăng dần khi sắp xếp các đơn vị đo thông tin: 

A. KB, GB, MB, TB   B. MB, TB, GB, KB 

C. KB, MB, GB, TB     D. TB, GB, MB, KB 

5. Loại máy tính nào thường dùng để chạy phần mềm chuyên môn hoá (specialized) và được dành để 

chia sẻ tài nguyên, quản lý nguồn dữ liệu lớn? 

A Netbook  B.Desktop  C.Tablet  D.Server  

6. Phần mềm hệ thống là? 

A. Chương trình hoặc hệ thống chương trình giúp máy tính hoạt động hoặc hỗ trợ hoạt động của hệ 

thống máy tính            

B. Hệ điều hành          

C. MS Office                  

D.Phần mềm cung cấp giao diện. 

7. Ý nghĩa của ký hiệu Hz là gì? 

A. Tốc độ xung nhịp bên trong của máy tính trong mỗi chu kỳ 

B. Tốc độ kết nối Internet  

C. Đơn vị đo dung lượng dữ liệu trên máy tính 

D. Tốc độ quay của quạt chip CPU. 

8. Bạn hiểu thuật ngữ Trojan của tin học là gì ? 

A. Nói tới loại viurs tin học chủ yếu lây lan vào các mẫu tin khởi động (Boot record) 

B. Là một loại mã độc tin học ẩn trên một website giả mạo chủ yếu đánh cắp dữ liệu người dùng  

C. Là loại virus tin học chủ yếu lây lan vào các tệp có khả năng thực thi khi người dùng vô tình 

kích hoạt. 

D. Là  một chương trình núp dưới dạng ứng dụng, thường lợi dụng (hoặc tạo ra) các lỗ hỏng hệ 

thống để đưa virus, phần mền gián điệp...xâm nhập hệ thống. 

 

TRẮC NGHIỆM PHẦN MẠNG & INTERNET 

 

9. Việc tải file dữ liệu từ internet bị chậm là do: 

A. File có dung lượng lớn  

B. Đường truyền internet tốc độ thấp. 

C. Server cung cấp dịch vụ internet bị quá tải 

D. Tất cả đều đúng 

10. Chọn phát biểu sai: 
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A. Mỗi máy tính tham gia vào mạng phải có địa chỉ duy nhất, được gọi là địa chỉ IP. 

B. Người dùng làm việc với địa chỉ IP cả dạng số và dạng kí tự 

C. Máy làm việc với địa chỉ IP dạng số còn người dùng chỉ làm việc với địa chỉ IP dạng kí tự. 

D. Địa chỉ IP dạng kí tự (tên miền) có thể gồm nhiều trường cách nhau bởi dấu chấm.  

 

11. Phát biểu nào dưới đây về trang web tĩnh là chính xác nhất? 

A. Là trang web chỉ chứa nội dung văn bản 

B. Là trang web không chứa hình ảnh động như đoạn phim video 

C. Là trang web không có khả năng tương tác với người dùng 

D. Là trang web không cung cấp chức năng tìm kiếm 

12. Phát biểu nào về website dưới đây là phù hợp nhất? 

A. Là một máy chủ cung cấp dịch vụ web 

B. Là một trang chủ 

C. Là một hoặc nhiều trang web được tổ chức dưới một địa chỉ truy cập 

D. Là một hoặc nhiều trang web của cùng một tổ chức 

13.Chức năng Bookmark của trình duyệt web dùng để: 

A. Lưu trang web về máy tính 

B. Đánh dấu trang web trên trình duyệt 

C. Đặt làm trang chủ 

D. Tất cả đều đúng 

14. Để chuyển tiếp thư, dùng nút 

 A.Reply   B.Reply to All  C.Forward D. Attachment 

15. Để truy cập vào một WebSite ta phải biết: 

A. WebSite đó được đặt tại đâu  

B. Tên miền của WebSite đó 

C. IP của máy chủ chứa WebSite đó  

D. Tất cả Sai 

 

16. Để mở một tab mới trên trình duyệt IE,Chrome…, ta sử dụng tổ hợp phím: 

A. Ctrl_T  B. Ctrl_Y  C. Ctrl_N  D. Ctrl_S 

17. SMTP, IMAP  là: 

A. Một dạng địa chỉ của hộp thư điện tử    

B. Một dạng đường dẫn của hộp thư điện tử   

C. Một dạng truyền dẫn trên internet  

D. Một dạng thức gửi/nhận EMail  

18. ISP là gì? 

A. Là nhà cung cấp dịch vụ Internet. 

B. Là nhà cung cấp cổng truy cập Internet cho các mạng. 

C. Là nhà cung cấp thông tin trên Internet. 

D. Tất cả đều đúng. 

19. Phần mềm nào sau đây không phải trình duyệt WEB? 

A. Microsoft Internet Explorer 

B. Mozilla Firefox 

C. Chrome 

D. Google Drive 

20. Địa chỉ nào sau đây là địa chỉ web không hợp lệ?  

A. tayninh.edu.vn 

B. ttgdtxtayninh.edu.vn 

C. phongnnth.ttgdtxtayninh.edu.vn 

D. phongnnth@ttgdtxtayninh.edu.vn 
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21.  Một máy tính cung cấp tài nguyên hoặc tạo ra các dịch vụ cho máy khác gọi là: 

 A. Supercomputer – siêu máy tính 

 B. Client – máy khách  

 C. Server – máy chủ   

 D. Workstation – máy trạm 

22. Mục đích chính của việc thiết lập một mạng máy tính là: 

 A. Để truy cập vào bất kỳ thiết bị máy tính nào trên mạng 

B. Để cho phép hai hay nhiều máy tính trên mạng có thể giao tiếp với nhau , chia sẻ tài nguyên hoặc 

trao đổi dữ liệu 

C. Để tạo danh sách liên hệ cho các cá nhân và doanh nghiệp trên mạng 

D. Để dễ dàng truy cập Internet 

23. Chương trình nào sau đây của Windows để duyệt web? 

    A. Microsoft Edge        B. Microsoft Egg 

    C. MS Dotnet         D. MS.NET 

24. Khẳng định nào sau đây là đúng  nhất về tin nhắn văn bản và tin nhắn tức thời: 

A. Tin nhắn văn bản được gửi qua mạng di động, tin nhắn tức thời gửi qua Internet 

B. Tin nhắn văn bản nhiều ký tự hơn tin nhắn tức thời. 

C. Tin nhắn văn bản đính kèm nhiều hình ảnh hơn tin nhắn tức thời.    

D. Câu A, B, C đều đúng. 

25. Muốn tìm thông tin về những tập tin DLL chỉ có trên website Microsoft.com, tiêu chí tìm kiếm được 

sử dụng là: 

A. DLL files site: microsoft.com 

B. DLL files link: microsoft 

C. DLL files host: microsoft 

D. DLL files AND microsoft.com 

26. Thiết bị mạng LAN nào giúp xác định điểm đến, điểm đi cho mỗi mạng : 

A. Hub          B. Switch 

C. Router         D. Bridge 
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TRẮC NGHIỆM WINDOWS 

 

27. Muốn thay đổi dạng số, kiểu hiển thị ngày tháng trong Windows ta vào Control Panel (hiển thị dạng 

Large Icon) tìm và thực thi từ Icon/lệnh: 

 A. Date/Time.     B. Region And Laguage.    

 C. System.      D. Win 10 không thay đổi được. 

28. Trong Windows, tập tin Shortcut là: 

 A. Một tập tin văn bản. 

 B. Một tập tin hệ thống. 

 C. Một tập tin khi thực thi sẽ mở một ứng dụng nào đó. 

 D. Một tập tin khi thực thi sẽ mở một thư mục hoặc file nào đó trên máy tính.   

29. Muốn xóa chương trình trong Windows, ta thực hiện: 

 A. Vào Control Panel tìm và thực thi các lệnh liên quan đến Hardware 

 B. Vào Control Panel tìm và thực thi từ các lệnh liên quan đến Uninstall hoặc Remove Programs.   

 C. Xoá biểu tượng trên màn hình Desktop 

 D. Các câu trên đều sai 

30. Chương trình nào sau đây có thể dùng để giải nén tập tin, thư mục: 

 A. WinZip B. WinRAR 

 C. Câu A và B đều sai D. Câu A và B đều đúng.   

31. Muốn cài thêm font mới trong windows, ta thực hiện: 

 A. Vào Control Panel, tiếp tục tìm và thực thi các lệnh liên quan đến Fonts để thêm.   

 B. Vào Control Panel tìm và thực thi các lệnh liên quan đến Programs 

 C. Vào MS Word chọn menu Format\Font. 

 D. Các câu trên đều sai. 

32. Để tạo thư mục trong Windows, ta thực hiện click phải chuột tại nơi cần tạo, chọn: 

 A. Properties. B. Refresh. 

 C. New\Folder.   D. Câu A, B, C sai. 

33. Trong môi trường Windows ta có thể chạy cùng lúc: 

 A. Hai chương trình. B. Chạy nhiều trình ứng dụng khác nhau.   

 C. Chỉ chạy một chương trình. D. Câu A, B, C sai. 

34. Trong Windows ta có thể tìm kiếm tập tin: 

 A. Theo kích thước . B. Theo ngày tháng tạo lập. 

 C. Theo kiểu tập tin. D. Các câu trên đều đúng.   

35. Trong Windows, để xóa hẳn tập tin, thư mục (không bỏ vào Recycle Bin) ta dùng tổ hợp phím: 

 A. Ctrl – Delete.  B. Alt – Delete. 

 C. Shift – Delete.   D. Tab – Delete. 

36. Trong hệ điều hành Windows, công dụng của phím Print Screen là gì? 

A. In màn hình hiện hành ra máy in. 

B. Không có công dụng gì khi sử dụng 1 mình nó. 

C. In văn bản hiện hành ra máy in. 

D. Chụp ảnh màn hình hiện hành vào vùng nhớ clipboard. 

37. Muốn phục hồi các tập tin, thư mục bị xóa trên đĩa cứng, ta thực hiện: 

 A. Mở Windows Explorer, vào File chọn Restore. 

 B. Mở Recycle Bin, chọn các tập tin/thư mục muốn phục hồi, Click phải chuột chọn Restore.   

 C. Mở Windows Explorer, vào Edit chọn Undo delete. 

 D. Không phục hồi được 

38. Trong Windows Explore để đổi tên thư mục, tập tin được chọn, ta thực hiện : 

 A. Click phải chuột\chọn Rename B. File\Rename 

 C. Nhấn F2 D. Câu A, B, C đúng.   



Đề cương ôn thi viên chức Y Tế tháng 12-2020- Trung tâm GDTX tỉnh Tây Ninh 
 

Trang 5 

 

39. Trong Windows Explore để đặt thuộc tính ẩn cho tập tin-thư mục, ta chọn tập tin – thư mục cần đặt 

thuộc tính rồi: 

 A.Click phải chuột/Properties. B. Vào menu View/Properties.   

 C. A hay B đều đúng. D. Trong Win 10 bỏ chức năng này. 

40. Chọn phát biểu đúng. Hệ điều hành Windows là: 

A. Hệ điều hành đa nhiệm B. Hệ điều hành có giao diện đồ họa. 

C. Câu A, B đúng.   D. Câu A, B sai. 
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TRẮC NGHIỆM PHẦN MS WORD  

41. Trong Microsoft Word để chọn tất cả văn bản ta thực hiện: 

 A. Ctrl – A.                                 B. Ctrl – C. 

 C. Ctrl – V.                                 D. Ctrl – X. 

42. Trong MS Word để làm kí tự đặc biệt(Symbol) lớn lên thì: 

 A.Bấm chuột vào góc và kéo ra  B. Khối kí tự rồi chọn cỡ chữ (Size) lớn 

 C.Sử sụng chức năng DropCap  D.Câu B và C đúng 

43. Trong MS Word, nhập Tiếng Việt có dấu không được có thể do: 

 A. Không có chương trình gõ tiếng việt.  B. Chọn kiểu gõ tiếng việt không phù hợp. 

 C. Chọn bảng mã không phù hợp.           D. Các câu a, b, c đúng.  

44. Chọn nhóm phím dùng trong soạn thảo văn bản để di chuyển con trỏ 

 A. Home, End, PageUp, Page Down  B. Các phím F1  đến F12 

 C. Caps Lock, Num Lock, Scroll  Lock           D. Shift, Alt, Ctrl 

45. Để đưa con trỏ văn bản về cuối dòng hiện hành, ta thực hiện: 

 A. Ctrl + Home     B. Ctrl + End 

 C. Home      D. End. 

46. Trong MS Word, sử dụng phím F12 dùng để: 

 A. Đổi chữ thường thành chữ IN HOA.       B. Phóng to cửa sổ. 

 C. Lưu tài liệu đang soạn thảo với tên khác.            D. Không làm gì cả. 

47. Font đang chọn là Tahoma, ta phải chọn bộ mã nào để có thể gõ được Tiếng Việt 

 A. TCVN3                                    B.VNI WINDOW 

 C. UNICODE                                D.UTF-8 

48. Khi soạn thảo văn bản, để khai báo thời gian tự lưu văn bản, ta chọn: 

    A. Tools - Option... Trong thẻ Save, đánh dấu chọn mục Save AutoRecover info every 

    B. File - Option... Trong thẻ Save, đánh dấu chọn mục Save AutoRecover info every 

    C. Format - Option... Trong thẻ Save, đánh dấu chọn mục Save AutoRecover info every 

    D. View - Option... Trong thẻ Save, đánh dấu chọn mục Save AutoRecover info every 

49. Trong Microsoft Word để chuyển đổi chế độ ghi đè ta gõ phím: 

 A. Ctrl                               B. Alt 

 C. Delete                          D. Insert 

50. Trong soạn thảo MS Word, công dụng của tổ hợp phím Ctrl - H là : 

    A. Tạo tệp văn bản mới       B. Chức năng thay thế trong soạn thảo 

    C. Định dạng chữ hoa       D. Lưu tệp văn bản vào đĩa 

51. Trong Word công cụ Justify để căng ký tự (canh lề) theo: 

 A. Lề trái                                B. Lề phải 

 C. Canh giữa                              D. Đều hai biên 

52.Trong định dạng văn bản, muốn chọn kiểu chữ gạch chân, ta sử dụng phím nóng: 

 A. Ctrl + B                      B. Ctrl + I 

 C. Ctrl + U                     D. Ctrl + A 

53. Trong MS Word, tổ hợp phím Ctrl-] dùng để : 

 A. Giảm 1 cỡ chữ.                                 B. Tăng 1 cỡ chữ. 

 C. Tăng 2 cỡ chữ.                                 D. Giảm 2 cỡ chữ. 

54.Trong MS Word tổ hợp phím  Ctrl _Shift _=  dùng để định dạng : 

 A. Chỉ số dưới (hệ số).                         B. Chỉ số trên (số mũ). 

 C. Không làm gì cả                              D. Câu A, B C sai. 

55. Trong MS Word sau khi khối đoạn văn bản rồi nhấn Ctrl-X thì: 

 A.Xóa đoạn văn bản đó   B. Dời đoạn văn bản đó sang vị trí mới 

 C.Sao chép thêm đoạn văn bản mới  D.Xóa đoạn văn bản đó và lưu vào clipboad  

56.Trong MS Word để làm chữ rỗng ta dùng chức năng sau đây trong hộp thoại định dạng Font: 

 A. Shadow      B. Outline 
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 C. Emboss     D. Engrave 

57.Trong Word, muốn chèn vào văn bản các kí tự đặc biệt như µ, α, π... ta chọn: 

 A. INSERT/Comment    B. INSERT/Footnote 

 C. INSERT/Caption     D. INSERT/Symbol 

58.Trong MS Word, ta có thể thực hiện được: 

 A. Làm lớn ký tự đầu tiên của Paragraph.   B. Định dạng dòng văn bản. 

 C. Chèn hình ảnh từ tập tin trên đĩa USB.  D. Câu A, B, C đúng. 

59.Trong Microsoft Word để xuống dòng mà không ngắt Paragraph, ta thực hiện: 

 A. Nhấn tổ hợp phím Ctrl-Enter.    B. Nhấn tổ hợp phím Alt-Enter.   

 C. Nhấn tổ hợp phím Shift-Enter.    D. Câu A, B, C sai. 

60.Trong MS Word, chức năng Dropcap dùng để: 

 A. Tạo bảng biểu.                                      B. Đổi chữ thường thành chữ  HOA. 

 C. Làm lớn ký tự đầu đoạn văn bản.          D. Câu A, B, C sai. 

61. Trong MS Word, biểu tượng Format Painter trên thanh công cụ dùng để: 

 A. Tô nền cho đoạn văn bản.   B. Sao chép định dạng. 

 C. Chèn công cụ vẽ hình.   D. Các câu A, B, C sai. 

62. Trong MS Word để ngắt cột cho đoạn văn bản (có chia cột), ta sử dụng tổ hợp phím: 

 A. Ctrl + Shift + Back                           B. Shift + Enter 

 C. Ctrl + Enter                      D. Ctrl + Shift + Enter  

63. MS Word, chức năng Split Cells dùng : 

 A. Tách một bảng biểu thành nhiều bảng.                 B. Tách một ô thành nhiều ô. 

 C. Câu A, B đúng.                                                 D. Câu A, B sai. 

64. Trong Word, muốn đánh chỉ số tự động ở đầu dòng cho các đoạn văn bản, ta sử dụng chức năng: 

 A. Format/Paragraph               B. Change Case 

 C. Borders and Shading      D. Bullets and Numbering 

65. Trong Word, muốn đánh số trang tự động , ta chọn : 

 A. FORMAT/Paragraph         B. FORMAT/Page number 

 C. INSERT/Page number      D. INSERT/Paragraph 

66. Phát biểu nào sau đây đúng? 

A. Biểu đồ cột rất thích hợp để so sánh dữ liệu có trong nhiều cột 

B. Biểu đồ hình tròn rất thích hợp để mô tả tỉ lệ của giá trị dữ liệu so với tổng thể 

C. Biểu đồ đường gấp khúc dùng so sánh dữ liệu và dự đoán xu thế tăng hay giảm của dữ liệu 

D. Cả 3 câu đều đúng  

67. Trong Word để  in trang hiện hành của văn bản đang mở thì nhấn nút lệnh Ctrl - P, sau đó chọn vùng 

in là : 

 A. Pages                                   B. Current Page 

 C. All pages                             D. Câu B và C đúng 

68. Trong Word, muốn thiết lập trang in theo chiều ngang, ta chọn : 

 A. Portrait                                   B. Landscape 

 C.Top                                         D. Bottom 

69. Trong MS Word để thêm một hàng nối đuôi vào bảng, ta định vị trỏ vào ô cuối cùng rồi gõ phím: 

 A. Insert                                       B.Alt 

 C.Ctlr - Tab                                D. Tab 

70. Trong MS Word, chức năng Merger Cells dùng : 

 A. Nhập các bảng biểu thành một bảng.                 B. Nhập các ô thành một ô. 

 C. Câu A, B đúng.                                                D. Câu A, B sai. 
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CÂU HỎI EXCEL   

71. Trong bảng tính Excel, nếu trong một ô tính có các kí hiệu #####, điều đó có nghĩa là gì? 

    A. Chương trình bảng tính bị nhiễm virus 

    B. Công thức nhập sai và Excel thông báo lỗi 

    C. Hàng chứa ô đó có độ cao quá thấp nên không hiển thị hết chữ số 

    D. Cột chứa ô đó có độ rộng quá hẹp nên không hiển thị hết chữ số 

72. Trong excel, để biết được ngày hiện tại trong hệ thống máy tính (không cần hiển thị giờ, phút, giây., 

ta sử dụng hàm nào trong các hàm có tên dưới đây 

A. Date B. Now   

C. Today    D. Year 

73. Trong bảng tính Excel, nếu trong một ô tính có biểu thức  =8^1/2^3  cho kết quả: 

   A. 12       B. Thông báo lỗi #Num? 

   C. 1   D. Thông báo lỗi #Name? 

74. Trong Excel, tại ô A2 có giá trị là chuỗi TINHOC. Tại ô B2 gõ công thức =RIGHT(A2,10) thì nhận 

được kết quả ? 

    A. 4               B. TINHOCNHOC                  C. TINHOC      D. 6 

 

75. Các tập tin bảng tính Excel có phần kiểu (phần mở rộng) là : 

A. EXE, EXEX  B. DOC,DOCX 

C. DAT,DATX D. XLS, XLSX  

76. Trong MS Excel chỉ có địa chỉ cột được thay đổi, còn địa chỉ dòng cố định khi ô chứa công thức được 

sao chép đến vị trí ô khác, thì gọi là địa chỉ gì? 

A. Địa chỉ tương đối. B. Địa chỉ tuyệt đối. 

C. Địa chỉ tương đối cột, tuyệt đối dòng.  D. Địa chỉ tuyệt đối cột, tương đối dòng. 

77. Trong MS Excel, khi nhấn tổ hợp phím Ctrl-Home có nghĩa là 

A. Chuyển về ô đầu tiên của bảng tính (ô A1).  B. Chuyển về ô cuối cùng của bảng tính 

C. Chuyển về ô đầu dòng.  D. Chuyển về ô cuối dòng. 

78. Trong MS Excel, khi nhấn phím Home có nghĩa là 

A. Chuyển về ô đầu tiên của bảng tính (ô A1).  B. Chuyển về ô cuối cùng của bảng tính 

C. Chuyển về ô đầu dòng.  D. Chuyển về ô cuối dòng. 

79. Trong Microsoft Excel chọn nhóm hàm chuỗi gồm: 

A. Left, Max, Min. B. Left, Right, Mid.   

C. Mid, Mod, Min. D. Value, Int, Round. 

80. Trong công thức của Excel, để nhập toán tử luỹ thừa (số mũ) ta dùng : 

A. Tổ hợp phím Ctrl_Shift_=. B. Tổ hợp phím Ctrl_=. 

C. Phím ^ . D. Không có toán tử này.  

81. Công thức $A3+$B3 tại ô C2 khi được chép sang ô D2 sẽ có dạng là: 

A. A4 + B3 B. A3 + B4 

C. A3 + B3 D. $A3 + $B3      

82. Trong Excel, toán tử “%” là : 

A. Phép chia lấy số dư. B. Phép chia lấy phần nguyên. 

C. Phép toán “phần trăm”. D. Không có toán tử này. 

83. Trong Excel, cặp toán tử “<” “ >” liền kề nhau dạng “<>”là: 

A. Cho biết giá trị “nằm trong khoảng”. B. Toán tử so sánh “khác nhau”.  

C. Thay cho toán tử “=”. D. Không sử dụng được. 

84. Giả sử ô A1= -3,2. Công thức Int(A1) có giá trị là bao nhiêu? 

A. -4 B. -3 

C. -2 D. 3 
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85. Trong Excel, để tính ô ThuếGTGT là 10% của ĐG (ĐG là giá trị hoặc địa chỉ của ô chứa giá trị Đơn 

Giá). ta chọn công thức tham khảo nào: 

A. =10% * ĐG     B. =10/100 * ĐG     

C. =0.01 * ĐG     D. Cả A, B đều đúng . 

 

86. Biểu thức sau cho kết quả là gì  

= “abcde” - “cde” 

A. Báo lỗi   B. 2  

C.  3 D. “ab”  

87. Giả sử ô A1 có giá trị số là 2, ô A2 có giá trị số là 3. Biểu thức sau cho kết quả là gì ? 

= A1&A2 

A. Báo lỗi     B. 5  

C.  Giá trị số 23  D. Chuỗi ký tự “23”  

88. Biểu thức sau cho kết quả là bao nhiêu?  

=Mod(8/3) 

A. 1     B. 2 

C. 3 D. Báo lỗi  

89. Biểu thức sau cho kết quả là bao nhiêu?  

=int(8/3) 

A. 1     B. 2  

C. 3 D. Báo lỗi  

90. Biểu thức sau cho kết quả là gì ? 

= “abc” + “cde” 

A. Báo lỗi    B. 6  

C.  “abccde” D. “abcde”  

91. Biểu thức sau cho kết quả là gì ? 

= int(-5/-3) 

A. 1     B. -1  

C.  2 D. -2  

92. Trong MS Excel, một cột có cả ô chứa giá trị số và ô chứa giá trị chuỗi. Khi ta sắp xếp dữ liệu với từ 

khoá Ascending (smallest to largest) thì dữ liệu trong cột sẽ được : 

 A. Sắp xếp tăng dần, thứ tự các giá trị chuỗi trước, số sau.  

 B. Sắp xếp tăng dần, thứ tự các giá trị số trước, chuỗi sau.  

 C. Chỉ sắp xếp tăng dần đối với ô kiểu số (Number). 

 D. Chỉ sắp xếp tăng dần đối với ô kiểu chuỗi (Text). 

93. Trong MS Excel, một cột có cả ô chứa giá trị số và ô chứa giá trị chuỗi. khi ta sắp xếp dữ liệu với từ 

khoá Descending (largest to smallest) thì dữ liệu trong cột sẽ được: 

 A. Sắp xếp giảm dần, thứ tự các giá trị chuỗi trước, số sau.  

 B. Sắp xếp giảm dần, thứ tự các giá trị số trước, chuỗi sau.  

 C. Chỉ sắp xếp giảm dần đối với ô kiểu số (Number). 

 D. Chỉ sắp xếp giảm dần đối với ô kiểu chuỗi (Text). 

94. Trong MS Excel ta có thể sắp xếp thứ tự với kiểu dữ liệu: 

 A. Kiểu Number. B. Kiểu Text 

 C. Kiểu Date/Time D. Không hạn chế kiểu dữ liệu 

95. Hàm có tên là SQRT trong Excel dùng để: 

A. Tính căn bậc hai.  B. Lấy phần dư của phép chia. 

C. Làm tròn số. D. Lấy giá trị tuyệt đối. 

96. Biểu thức sau cho kết quả là gì:         =Max(2,3,7,9,e) 

A. 2  B. 9 

C. #Name?     D. #Value! 
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97. Trong MS Excel, hàm có tên là ROUND dùng để: 

A. Lấy phần nguyên của số. B. Lấy phần dư của phép chia   

C. Làm tròn số. D. Câu A, B, C sai. 

98. Giả sử ô A1 có dữ liệu “TT GDTX TN”, để lấy chuỗi “GDTX” ta có thể dùng công thức: 

 A. =Mid(A1,2,4) B. =Mid(A1,3,4) 

 C. =Mid(A1,4,4)   D. =Mid(A1,4,3) 

99. Trong bảng tính Excel, tại ô A2 có sẵn giá trị số 25 ; Tại ô B2 gõ vào công thức =SQRT(A2) thì 

nhận được kết quả:      

A. 0               B. 5                C. #VALUE!      D. #NAME! 

100. Trong bảng tính Excel, tại ô A2 có sẵn giá trị chuỗi "Tin hoc"; ô B2 có giá trị số 2008. Tại ô C2 gõ 

vào công thức =A2+B2 thì nhận được kết quả:  

A. #VALUE!          B. Tin hoc             C. 2008                D. Tin hoc2008 
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CÂU HỎI TRẮC NGHIỆM ÔN TẬP MS-POWERPOINT 
 

101. Trong PowerPoint, 1 slide có thể có tối đa bao nhiêu hiệu ứng Transition: 

A. 1   B. 2   C. 3  D. Rất nhiều  

102. Trong MS PowerPoint . Âm thanh đưa vào bài trình diễn  

 A. Thực hiện được chỉ khi tạo hiệu ứng động cho đối tượng trong slide. 

 B. Thực hiện được chỉ khi tạo hiệu ứng chuyển trang giữa các slide. 

 C. Thực hiện được cả khi tạo hiệu ứng động và hiệu ứng chuyển trang. 

 D. Không thực hiện được cả khi tạo hiệu ứng động và hiệu ứng chuyển trang. 

. 

103. Trong MS PowerPoint, để các slide đều có tên tác giả khi trình chiếu ở Footer, ta thực hiện tổ hợp 

phím nào sau đây?  

A.  ALT+V+A B.  ALT+I+W C.  ALT+V+H D.  ALT+I+I 

 

104. Chức năng Animation/ Timing/ Delay dùng để: 

A.Thiết lập thời gian chờ trước khi slide được trình chiếu 

B.Thiết lập thời gian chờ trước khi hiệu ứng bắt đầu 

C.Thiết lập thời gian hoạt động cho tất cả các hiệu ứng 

D.Tất cả đều đúng 

105. Khi đang làm việc với PowerPoint, muốn thiết lập lại bố cục (trình bày về văn bản, hình ảnh, biểu 

đồ,...) của Slide, ta thực hiện : 

 A. HOME - Slide Layout...     B. VIEW - Slide Layout... 

 C. INSERT - Slide Layout...     D. FILE - Slide Layout... 

106. Trong MS PowerPoint. Đang trình chiếu một bài trình diễn, muốn dừng trình diễn ta nhấn phím 

A. Tab       B. Esc  

C. Home      D. End 

107. Trong MS PowerPoint . Thao tác chọn File -> Open là để  

A. Mở một presentation đã có trên đĩa   

B. Tạo mới một presentation để thiết kế bài trình diễn 

C. Lưu lại presentation đang thiết kế 

D. Lưu lại presentation đang thiết kế với một tên khác 

108. Trong khi thiết kế một trình chiếu với PowerPoint, thực hiện thao tác chọn Insert -> New Slide là để 

A. Chèn thêm một slide mới vào ngay trước slide hiện hành 

B. Chèn thêm một slide mới vào ngay sau slide hiện hành 

C. Chèn thêm một slide mới vào ngay trước slide đầu tiên 

 D. Chèn thêm một slide mới vào ngay sau slide cuối cùng 

109. Trong MS PowerPoint, để chèn một slide mới, sử dụng tổ hợp phím 

 A. Ctrl + N    B. Ctrl + L 

 C. Ctrl + M    D. Ctrl + K 

110. MS PowerPoint, thao tác chọn Delete Slide là để 

 A. Xóa slide hiện hành   

 B. Xóa tập tin có nội dung là bài trình diễn hiện hành 

 C. Xóa tất cả các slide trong bài trình diễn đang thiết kế 

 D. Xóa tất cả các đối tượng trong slide hiện hành 

 

111. Trong MS PowerPoint , để thực hiện việc chèn bảng biểu vào slide ta phải 

 A. Chọn Table -> Insert Table   B. Chọn Table -> Insert 

 C. Chọn Insert -> Table    D. Chọn Format -> Table 

112. Trong MS PowerPoint. Thực hiện thao tác liên quan Animation là để 
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 A. Tạo hiệu ứng động cho một đối tượng trong slide 

 B. Tạo hiệu ứng chuyển trang cho các slide trong bài trình diễn  

 C. Đưa hình ảnh hoặc âm thanh vào bài trình diễn 

 D. Định dạng cách bố trí các khối văn bản, hình ảnh, đồ thị ... cho một slide 

113. Trong MS PowerPoint Chọn phát biểu sai: 

 A. Khi tạo hiệu ứng động cho một khối văn bản ta có thể cho xuất hiện lần lượt từng từ trong khối 

văn bản khi trình chiếu 

 B. Sau khi đã tạo hiệu ứng động cho một đối tượng nào đó ta không thể thay đổi kiểu hiệu ứng 

cho đối tượng đó 

 C. Có thể thực hiện hiệu ứng chuyển trang cho 1 slide bất kỳ trong bài trình diễn 

 D. Có thể thực hiện hiệu ứng chuyển trang cho tất cả các slide trong bài trình diễn 

114. Khi đang làm việc với PowerPoint (Office 2013), muốn các thiết kế mẫu có sẵn cho Slide (Theme), 

ta thực hiện từ Ribbon: 

A. HOME - Slide Design - Theme       B. TOOL - Slide Design – Theme 

C. INSERT - Slide Design Theme         D. DESIGN - Theme  

115. Trong MS Powerpoint, loại hiệu ứng nào sau đây dùng để di chuyển đối tượng khi trình chiếu: 

 A. Emphasis B. Exit C. Entrance D. Motion Paths 

116. Muốn ẩn/hiện thanh công cụ trên màn hình soạn thảo PowerPoint, người sử dụng phải 

A. Chọn File ->Exit 

B. Nhấn F1 

C. Nhấn Ctrl+ F1 

D. Không ẩn được 

117. Trong MS PowerPoint, có thể có tối đa bao nhiêu hiệu ứng Animation cho một đối tượng hiển thị: 

A. 1   B. 2   C. 3  D. Rất nhiều  

118. Trong MS PowerPoint, để lưu bài trình chiếu như một tập tin trình chiếu mẫu (Template), ta lưu 

phần mở rộng (kiểu tâp tin) dạng : 

A. POTX   B.PPTX  C. PPTM   D. PPSX 

119. Trong MS PowerPoint, để tạo một slide mẫu trình chiếu cá nhân (Slide Master), ta thực hiện : 

 A. Design/Insert Slide Master   B. Insert/ Slide Master /New 

 C. New/Insert Slide Master   D. View/ Slide Master/ Insert Slide Master 

120. Trong PowerPoint, để thay đổi Theme cho một Slide mà không làm ảnh hưởng đến Slide khác ta 

thực hiện lệnh:   

A. Design/Theme/Click chuột phải trên mẫu Theme/Apply to Matching Slides 

B. Design/Theme/Click chuột phải trên mẫu Theme/Apply to Selected Slides 

C. Design/Theme/Click chuột phải trên mẫu Theme/Apply to All Slides 

D. Không thể thực hiện 

HẾT 

 

 

 


